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About this Tutorial 
 
This tutorial is designed as a learning exercise, stepping the user through the data analysis 
and structure refinement procedures used for the Single Crystal Diffractometer (SCD) at 
IPNS.  Using ISAW, the user will visually inspect sample data, determine an orientation 
matrix and integrate resulting peaks.  Using IPNS helper programs, data will be corrected 
and processed for structure refinement.  The structure can then be refined using an 
available refinement program such as GSAS or SHELX.  The goal of the tutorial is 
provide you, the user, with knowledge of the software so that you can analyze your data.   
 
This version of the tutorial is based on the ISAW 1.8 release.  This new release has some 
improvements over the 1.7 series of releases.  If you are running a version of ISAW in 
the 1.7 series, it is recommended that you upgrade to a 1.8 release. 
 
This general tutorial may not answer all of the questions a user may have, nor will it 
address special circumstances.  IPNS personnel are always on hand to answer questions 
that may arise. 
 
This is also a work in progress.  Suggestions are welcome to help this become a better 
learning tool for our users.  Suggestions and comments can be addressed to 
ppiccoli@anl.gov. 
 

What You Will Need 
 
Start by visiting the SCD webpage located at: 
 
http://www.pns.anl.gov/instruments/scd/ and 
http://www.pns.anl.gov/instruments/scd/subscd/scd.shtml. 
 
Download ISAW, GSAS, and the Oxalic Acid Tutorial from the Useful Links and 
Downloads.  Install ISAW into a C:\isaw directory, and GSAS into C:\gsas.  Open the file 
isaw_exec.bat with a text editor and replace ”256” in the line “java –mx256m -cp” with a 
larger value if your computer has more than 256MB of memory.  ISAW version 1.8 
requires the Java runtime environment (JRE) 1.5 or higher to work on the PC.  (Previous 
versions of ISAW require a JRE of 1.4.2 or higher.)  You can download this from the 
ISAW page. 
 
Make a directory C:\scd directory, and unzip the tutorial programs here.  The result 
should give C:\scd\exe, as well as the files C:\scd\Absorption.xls, C:\scd\spec_coeff.dat 
and C:\scd\instprm.dat.  Because some of the helper programs are hardwired to look for 
certain files in certain places, make sure that these folders and files are in the correct 
places.  The anvred.log file is from a 80 K data collection on oxalic acid, and contains the 
correct absorption correction values that are also listed within this tutorial. 
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GSAS is the standard program for refining data at IPNS due to the fact that it handles 
multiple histograms and extinction from neutrons very well.  SHELX may also be used, 
for which we usually supply a scaled and extinction corrected hkl file from initial GSAS 
refinement. 
 
ORTEP will directly read GSAS or SHELX files for graphical representations of the final 
structure.  It is also compatible with the WinGX package, which offers other programs 
for plotting the structure. 
 
To run these helper programs as well as GSAS directly from a DOS window prompt, set 
the PC system path variable to include C:\scd\exe;C:\GSAS\exe and add a new system 
variable GSAS to be C:\GSAS\ (assuming this is where the downloaded GSAS is 
located). 
 
WinGX and ORTEP also require information to be placed in the path, and are specified at 
their websites. 
 
The following page illustrates the data collection and analysis process for the SCD at 
IPNS, and outlines the programs used for each step.  The Glossary at the end of this 
tutorial gives a brief description of programs or terms used throughout. 
 
Happy refinements! 
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About Oxalic Acid 
 
The bundle containing this tutorial also contains two papers from the literature about 
oxalic acid (PDF formatted).  Unit cell information needed to work on this tutorial can be 
found in the paper.  A file named atoms.txt is also included in the tutorial bundle.  This 
file contains the atoms and their positional parameters from structure refinements over 
several temperatures at IPNS.  This information is necessary to enter the atoms and their 
fractional coordinates into GSAS during the refinement stages. 
 
The experimental data was collected at 80 K on SCD at IPNS.  The run files are compiled 
in a zip file and when extracted should end up in a “working directory” separate from the 
rest of the information downloaded from the website. 
 
The goal in an experiment such as oxalic acid is to locate the nuclear positions of the 
hydrogen atoms – try leaving out one or two of the hydrogen atoms and find them in a 
difference Fourier map during refinement of the structure. 
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Data Visualization 
 

Getting Started 
 
ISAW is a data visualization program used to view, analyze and integrate raw data from 
SCD (as well as other instruments at IPNS).  Information about computing practices at 
IPNS can be found at: 
 
http://www.pns.anl.gov/computing/ 
 
You may run ISAW from your PC desktop or remotely on the SCD front end computer 
helios.pns.anl.gov.  Data run files can also be downloaded to your PC via the SSH file 
transfer window, and these same operations can be run locally on your PC (useful if your 
computer connection is slow or you take your data with you – xterm windows have a 
tendency to time out if the connection is too slow).  The above link provides information 
on downloading the latest version of ISAW and the java run time environment (JRE).  
Java must be installed on the computer intended to run ISAW.  These are provided free 
to the user. 
 

Launching ISAW 
  
Launch ISAW by double-clicking on the ISAW icon or by typing ISAW from a DOS 
command window prompt.  The initial ISAW screen should become visible at this point: 
 

 
Figure 1 
 
Entries under the Help item on the menu bar offer some introduction and online 
documentation.  
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The status bar at the bottom of the ISAW screen is an output screen.  As operations are 
conducted in ISAW, this screen will provide information about what ISAW is doing and 
some brief results.  Check the Status bar if something goes wrong in an operation; ISAW 
is quick to tell you if the input is incorrect. 
 

Viewing the Data 
 
Raw data may be viewed in ISAW by using the File > Load Data > Local 
menu options to load specific run files into ISAW: 
 

 
Figure 2 
 
SCD run files have the extension .run.  Raw data files stored on the scd computer will be 
found in the scd/data folder.  Files in the example here are from a local folder on the 
PC’s hard drive.  Run files may be selected by selecting them and then selecting the Open 
button.  This will then load the run file into ISAW for viewing purposes. 
 
The startup ISAW screen will come back into the foreground with the run file appearing 
below the Session box in the left hand window.  Clicking on the circle just to the left of 
the run file folder in this window will expand the folder to show the contents M1, P1 and 
H1.  H1 contains the histogram information (raw data) to use for viewing the data.  Click 
once on H1: 
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Figure 3 
 
Information about the run file now appears in the Attributes box.  The scroll bar on the 
right hand side will also give information about what time the run finished, how many 
pulses were collected, the sample orientation and the user name. 
 
From the menu bar, select View > Image View to see time-of-flight spectra of each 
pixel on the area detectors.   
 
Selecting View > 3D View will bring up the view of both detectors.  The two views are 
linked in that clicking on a spot in the Image View will show you the corresponding 
reflection collected on each detector.  The user can scroll through the data in time-of-
flight by using the right hand scroll bar in Image View or the left and right arrow buttons 
in the 3D view. 
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Figure 4 
 
In this way the raw data may be viewed.  It is a good way to examine the overall quality 
of the crystal and subsequent data. 
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 Initial Peaks Wizard  
 
The purpose of this wizard is to find and autoindex peaks to obtain the unit cell and the 
orientation matrix. 
 

Form 1: FindMultiplePeaks 
 
Data do not need to be loaded initially into ISAW in order to run the Initial Peaks 
Wizard.   
 

1. From the initial ISAW screen, go to Wizards > SCD > Initial Peaks Wizard 
 

 
Figure 5 
 

2. Set the Project Directory to C:\scd\Tutorial\Oxalic acid.  The instrument 
calibration file instparm.dat (see step 7) has also been copied to this directory. 
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3. Set the Run Numbers to 9164:9166.  The colon indicates that all numbers in the 
series are included.   

4. Choose an Experiment name that will identify it easily.  Choose ox80. 
5. Default values for Form 1 will locate up to 30 peaks from each detector in each 

run file with a minimum peak intensity of 10, with a maximum time 
channel of 1000 (this should cover all of the SCD run file data).   

6. Initially there is no data file to append to, so leave this box unchecked.   
7. Make sure the correct calibration file is used!  The most recent instrument 

parameter files (SCD Calibration File) are located in the scd home directory on 
helios and has the file name instprm_Jun04.dat or something similar.  These files 
are always dated with the month and year, and it is important to use the most 
recent file for when the data was collected.  (This may not always be the “most 
recent” calibration file).  For this example, the file instparm.dat has been 
provided.  Please remember that this file will not be the one used for your data 
collection. 

8. Pixel Rows and Columns to Keep allows the user to reject some detector 
pixels; this does not need to be adjusted to find the orientation matrix. 

9. When input is complete, click on the Do box to find the peaks from the specified 
run files.  When the FindMultiplePeaksForm has completed, the top progress 
bar will change color as shown below.  The bottom bar shows that you have 
complete 1 of the 6 Forms in the wizard. 

 

 
Figure 6 

Also, in the message pane of the ISAW window, there will be a message “--- Done 
finding peaks. ---Peaks are listed in C:/scd/Tutorial/Oxalic acid/ox80.peaks.” 

 
Files written:  filename.peaks (ox80.peaks) which may be viewed by selecting View > 
Peaks File from the menu bar.   
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Figure 7 
 
The file shows the peaks found in the search.  Note that they are not indexed – there is no 
orientation matrix yet.  The first two lines contain information about the run number, 
detector identification and parameters, and the diffractometer setting used for that run 
file.  SEQN is the sequence number of the reflections searched for by ISAW.  X, Y and Z 
refer to detector horizontal and vertical channels X and Y (0:100), and Z, the time 
channel of the neutron collected by the detector.  These channels are listed as nonintegers 
due to a peak centroid analysis of the peak maximum channel and the 26 nearest 
neighbors.  XCM and YCM refer to the position of the peak in units of cm from the 
center of the detector.  WL is the wavelength of the reflection in Angstroms.  IPK is the 
neutron counts in the XYZ channel at the peak maximum, INTI will be the integrated 
intensity and SIGI is the standard deviation after integration of the reflection. 
 

10. Choose five to fifteen peaks of medium to high intensity by sequence number 
for unit cell determination to enter into Form 2.  Select the Forward One 
button at the bottom of the Form 1 page to advance to Form 2. 
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Form 2: JBlind 
 
JBlind is a program that attempts to find an orientation matrix from a sequence of peaks.   
 

 
Figure 8 
 

11. Input the peaks, separated by commas, in the Peak sequence numbers 
window.  (You can use the peaks here in the example, or experiment with 
your own!) 

12. A Matrix file name will need to be provided with the .mat extension.  Choose 
ox80.mat. 

13. Click Do. 
 
Files written: blind.log and filename.mat (specified above).  View either file using the 
View item on the menu bar. 
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Figure 9 
 
It can be seen that the axes are of the correct length but not in the correct order, which 
can be changed in a later form.  Note that if Blind does not find the correct cell 
(conventional or reduced) the peak sequence numbers can be changed and the form run 
again.  Occasionally Blind works better with fewer peaks.  Form 2 will write over the log 
and matrix files, so remember to copy them to different files if saving them is important.  
Once a satisfactory matrix has been determined, click Forward One to move to the next 
form. 
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Form 3: JIndex 
 
JIndex will index the peaks located in the peaks file (but not all of the peaks in the data).  
It is a good measure of how well the orientation matrix fits the data.   
 

 
Figure 10 
 

14. Use the Restrict Runs option if only a few runs (in the peaks file) are of 
interest; otherwise leave it blank.   

15. Delta h, k, and l specify the tolerance of when to consider a peak properly 
indexed.  The tolerance can be changed depending on the quality of the 
crystal, the accuracy of the initial orientation matrix, and the size of the unit 
cell.  For small unit cells, 0.1 may be suitable, whereas for large unit cells, 0.3 
may be necessary.  A value of 0.2 is the default number which is suitable to 
start with.   

16. Check the box to Update the peaks file – when you view the peaks file 
after Form 3 it will have the indexed hkl values of each peak. 
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Files written: the updated filename.peaks file and index.log.  View these as before from 
the menu bar.  The Status bar from the main ISAW window will inform you of the 
success rate of indexing (in this case, 170 of 180 peaks were indexed).   
 

17. Go Forward One to reach Form 4. 
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Form 4: JScalar 
 

 
Figure 11 
 
JScalar will assist in finding the correct transformation matrix for the initial orientation 
matrix if this is necessary by examining relationships of the elements of the metric tensor, 
but note that it is not foolproof if the initial matrix is not very precise!  While JScalar 
works quite well most of the time, there are times when the user needs to intercede.  The 
default is for No Restriction in terms of Symmetry Constraints.  The figure above 
shows the drop menu in which the user can specify symmetry constraints.  It is always 
worthwhile to run JScalar with no restrictions on symmetry to determine if the program 
can get the transformation matrix right on the first try.  If it can’t then imposing a 
symmetry constraint can help, especially in the case of a reduced cell. 
 
Files written: scalar.log, which lists various transformation matrices (if it found any) and 
the resulting unit cells.  In this case, the second transformation matrix (cell choice 2) to a 
primitive, monoclinic cell is the correct one for oxalic acid. 
 
Go Forward One to reach Form 5 and perform the transformation. 
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Figure 12 
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Form 5: JLsqrs 
 

 
Figure 13 
 

18. The Matrix file to write to must be specified.  A new name may be chosen 
if the initial orientation matrix needs to be preserved; otherwise that initial file 
may be chosen and subsequently overwritten. 

19. The Transform Matrix is written across rows and not down columns, 
therefore the matrix from JScalar: 

 
   P, MONOCLINIC 
 
 TRANSFORMATION MATRIX 2  IS 
 
  -1    0    0           0.064050  -0.130746   0.085297  
   0    0    1  x UB =   0.254941   0.131492   0.011164  
   0    1    0          -0.013848   0.021545   0.082804 
 

Will be written as [[-1, 0, 0][0, 0, 1][0, 1, 0]] in Form 5 above.   
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20. Version 1.8 of ISAW includes a Cell Type Constraint pull-down menu.  

This feature will fix those cell parameters imposed by Bravais lattice 
symmetry and refine the cell against these parameters.  In this case, we know 
that oxalic acid is a monoclinic cell with a unique b-axis, and so the resulting 
α and γ angles should be exactly 90° with no errors.  The resulting matrix may 
be viewed to confirm the transformation.  Compare this with the original 
orientation matrix.  This appears to be the correct unit cell for oxalic acid.  
You will notice that the output below has errors associated with it for both α 
and γ, however these would not be reported in subsequent crystallographic 
reports.  Currently, ISAW is being improved to not report these errors. 

 

 
Figure 14 
 
Files written: the new filename.mat file as specified above.  In this case, we have chosen 
to overwrite the ox80.mat file. 
 

21. Click Do to move to the next form. 
 
Form 6 is another iteration of JIndex.   
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Figure 15 
 

22. Input the correct (most recent in this case) matrix file.  JIndex will reindex the 
peaks in the peaks file to be consistent with the correct orientation matrix.  Now 
you are almost finished with the Initial Wizard. 

 
 

23. You might have noticed that the oxalic acid structure in the original literature has 
been solved in the space group P21/n.  This space group is a nonstandard setting 
for P21/c.  Although the unit cell you have just determined looks correct for oxalic 
acid, in fact what you have just found is the cell for the conventional setting.  In 
order to refine oxalic acid data in P21/n, we will need to transform the cell from 
cell choice 1 (P21/c) to cell choice 2 (P21/n).  The 3 x 3  transformation matrix 
can be found in Table 5.1 of the International Tables for Crystallography, Volume 
A.  Return to Form 5 and enter [[-1,0,-1][0,1,0][1,0,0]] in the Transform 
Matrix box, remembering to write the matrix out to another file such as ox80-
t2.mat.  The following matrix file should be written: 
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Notice that the β angle value has changed slightly, and that a and c are in opposite 
positions.  We will correct this momentarily. 

 
 

24. Go forward to Form 6 and index the peaks again with the new matrix file. 
 

25. To change a and c and obtain the correct matrix to match the literature values, 
return to Form 5 and enter [[0,0,1][0,1,0][1,0,0]] in the Transform Matrix 
box., saving the matrix file yet again to a new name such as ox80-t3.mat: 

 

 
 

26. Again, return to Form 6 and index the peaks with the new, correct matrix file 
determined in step 25 above.   

 
Files written: the Initial Wizard writes a file named filename.x, which is essential to move 
to the next step of the process, which is integration of all of the peaks in the run file.  
Make sure that this file exists before moving on to integration.  The orientation matrix 
determined in the above steps may be used as a starting point for indexing and integrating 
the data set. 
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Daily Peaks Wizard – integrating the data 
  
Integrating peaks in ISAW using the Daily Wizard is very similar to using the Initial 
Wizard – in fact, there are fewer steps to the procedure.   
 

Form 1: FindMultiplePeaksForm 
 

1. Launch the Daily Wizard using the Wizards > SCD > Daily Peaks Wizard 
routine: 

  

 
Figure 16 
 

2. Input all of the Run Numbers for a complete integration of the data set 
(9164:9183).   

3. Do not Append Data to File unless only a portion of the data had been 
integrated previously and the user intends to integrate additional run files from the 
same data set.   
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Occasionally, and especially for a long data collection, portions of the data may be 
integrated, reduced and put into GSAS for a quick check of the quality of the data.  In this 
event, Daily Peaks can be executed for specific ranges of run files – for example, if there 
are a total of 18 runs in a data collection, the data might be integrated from runs 1:9.  
These data might be examined in refinements of the structure in GSAS.  To integrate the 
remainder of the data, the user would then run Daily Peaks for runs 10:18.  Details on 
incorporating this kind of “additional” data into GSAS after data reduction will be 
explained later. 
 

4. Input the SCD Calibration File. 
5. Click on Do to execute Form 1 and find peaks for each run file (even if some of 

these files were used to find the orientation matrix).  Then move on to Form 2. 
 

Form 2: IndexJForm 
 

 
Figure 17 
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Here the peaks are indexed using the matrix determined previously.  The orientation 
matrix determined prior to data collection may be used here or the orientation matrix can 
be redetermined from the actual data collection.  
 

6. Make sure to have the correct Matrix File to Load, especially if you have saved 
a transformed matrix to a different file name. 

7. Click on Do. 
 
Check the status bar to find out how many peaks have been indexed.  If this number is 
not very large, try increasing the delta values from 0.1 to 0.2.  The next form (JLsqrs) 
will fit each individual run file with its own orientation matrix.  After this step you may 
return to Form 2 and re-index the peaks using the Get Matrix File From: From 
LsqrsJ option. 
  

8. Move on to Form 3 when the peaks have been indexed. 
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Form 3: LsqrsJForm 
 

Figure 18 
 
Default values may be used for Form 3, except for the Cell Type Constraint which 
is new with this release.  It is suggested that you choose Triclinic (i.e., no constraints) 
at this stage in order to accurately calculated peak positions and integrated intensities. 
The LsqrsJForm will refine the loaded matrix file against each run file and write an 
individual orientation matrix for each run file to allow for small misalignments of the 
sample during data collection.  Each of these matrices may be viewed after the 
procedure is complete.  Matrices written will be labeled with the experiment name, 
run file number and the letters “ls” in front of it (for example, “lsox809164.mat”).  
Additionally, an overall ls matrix file (“lsox80.mat”) is written for the overall data set.  
This matrix, is now correct by symmetry constraints (i.e. the 90° angles are 
constrained to be 90°), is the one used during data reduction and GSAS file creation.  
Do not report the errors given by ISAW in subsequent publications of the unit cell 
parameters. 
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9. Click on Do to write the least squares matrices and then, if you are satisfied, 
move on to the integration step.  Least squares matrices can be used to re-index 
peaks in Form 2 in order to obtain more accurate least squares matrices. 
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Form 4: IntegrateMultiRunsForm 
 

 
Figure 19 
 
Form 4 is where integration takes place.   

10. Run Numbers may be restricted to include all or part of the total data 
(depending on which section of the data is needed).   

11. If Append to File is not checked, this information will be lost, however if portions 
of the data have already been integrated (example 1:9) then do not re-integrate 
this data and append it or there will be redundant data.   

12. Make sure that the Centering Type information is correct.   
13. Unless there is an unusual circumstance regarding the quality of the data, use the 

default values for the Time-Slice Range and Amount to Increase Slice By.  
The time-slice range values of -1:3 refer to the relative time channels about the 
peak center for a total of 5 channels. The value of 1 in the next box refers to the 
increase in the peak dimensions on each time-slice. This is a value added to the 
maximum I/σ(I) (see next item) dimenstion in order to make sure that the entire 
peak is integrated. 
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14. A drop-down menu allows the method of integration can be specified; the 
standard method of maxI/sigI is useful for most applications.  This is a three-
dimensional Lehman-Larson integration for which the peak size is varied to 
maximize the I/σ(I) ratio.  Note: do not use the maxI/sigI – old integration 
routine! 

 
Files written: filename.integrate, integrate.log.  It may be viewed in ISAW (this could 
take some time to open) or opened with a text editor (faster).  Compare the .integrate file 
with the .peaks file written in Form 1 of the Initial Wizard – it can be seen that the peaks 
are now integrated.  The integrate.log file is useful in examining the peak dimensions and 
intensities on each time-slice for that peak. 
 
You have now integrated the data and are ready to move on to the data reduction stage. 
 

 
Figure 20 
 
ISAW writes two files that are needed for the data reduction process: 
 filename.mat 
 filename.integrate 
If any of these ISAW processes were conducted remotely on helios, the above two files 
need to be downloaded to the computer where refinements will be taking place.  If ISAW 
was run on your local computer in your working directory, you already have them. 
 
* For instructions on how to integrate portions of data and process them for refinement 
on a daily basis, see Appendix 2. 
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Calculating the Absorption Correction 
 
The Excel spreadsheet Absorption.xls (found in the C:\scd directory) is designed to 
calculate the linear absorption coefficients for the sample, as well as the radius of the 
sample in cm.  The program anvred will use these numbers as part of the data reduction.  
Input the numbers listed in red into the file: number of atoms in the formula unit, Z, cell 
volume and weight of the crystal (in mg). 
 
The linear absorption coefficient is 
 

 ∑=
i

iin
V
Z σµ  

where Z is the number of formula units in the unit cell, V is the unit cell volume in Å3, ni 
is the number of atoms of a particular element or isotope in the formula unit, and σi is 
either the total cross section or the true absorption cross section for atom i in barns (10-24 
cm2). 
 
The three numbers from this spreadsheet that you will need for anvred are: 
 µs:  the total scattering linear absorption coefficient, including both coherent and  
  incoherent scattering 
 µa:  the linear absorption coefficient for true absorption 
 R (in cm) 
 
For oxalic acid the numbers you will need are: 
 µs = 1.302 cm-1 
 µa = 1.686 cm-1 
 R  = 0.170 cm 
 
In the event that you have a sample that does not have an element listed in the 
spreadsheet, go to: 
 
http://www.ncnr.nist.gov/resources/n-lengths/ 
 
and click on the element you wish to enter into the spreadsheet.  You will want to enter 
the total scattering cross section into the σ-s column and the absorption cross section for 
2200 m/s neutrons (Abs xs) into the σ-a column, as well as the atomic weight. 
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Correcting the Data for Absorption - Anvred 
 
The Fortran program anvred will correct the data for sample absorption, the incident 
spectrum, and the efficiency of the 6Li glass scintillation detector.  From a DOS 
command window in your working directory, type 
 
>anvred 
 
to launch the program.   The following screen should appear.  If it does not, make sure 
the PC system path variable PATH= C:\scd\exe. 
 
 
 

 
Figure 21 
 

1. Enter the experiment name (ox80) without any file extension.   
2. Assuming that the EXPNAM is the same as you have chosen from ISAW, the 

defaults can be taken for input and output reflection file.   
3. Use the overall least squares matrix (lsox80.mat) as the matrix filename and 

type. 
4. Enter the number that corresponds to the correct cell type (1). 
5. Enter y to do the absorption correction. 
6. Enter µs and µa from the Absorption.xls spreadsheet. 
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Figure 22 
 

7. Answer y if the numbers you entered are correct. 
8. Type 2 to do a spherical (Gaussian) correction. 
9. Enter the radius of the crystal (in cm) as calculated by Absorption.xls (0.170). 

 

 
Figure 23 
 

10. Enter 1 to correct for the incident spectrum. 
11. Enter 14 to select the correct incident spectrum coefficient.  If this step results in 

the program quitting, make sure that the file spec_coeff.dat is located in the C:\scd 
directory.  Option 14 is the most recent spectral coefficient correction (2005). 
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Figure 24 
 

12. Input 2 select the parameters for calculating the linear absorption coefficient of 
the glass scintillator. 

13. Use the default input for minimum I/sigI, and number of X and Y detector 
channels to include all of the data. 

14. Set N = 5 to reject peaks within 5 channels of the border. 
15. Type y to reject peaks for which the centroid calculation fails. 
16. Use the default of 0 for minimum peak count. 
17. Set a minimum d-spacing of 0.5.  (This is a general standard.  If data are 

especially weak and noisy, this level can be changed here.  GSAS also has a way 
to set a cutoff for d-spacing, so it can be changed to a higher number during 
refinement if necessary). 

18. Use a scaling factor of 1.0 to apply to F2 and σF2. 
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Figure 25 
 
At this point anvred will process and correct the data.  There should be twice as many 
histogram numbers as there are run files.  Maximum and minimum transmission are 
reported for the sample (this information is contained in the log file). 
 
Files written: expnam.hkl, anvred.log.  This file is a text file that can be reviewed by 
opening it with a text editor. 
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Writing Files for Structure Refinement – anv2gsas 
 
 
The Fortran program anv2gsas will write the single crystal reflection files used by GSAS 
to do refinements.  It will write information to the GSAS experimental file expnam.exp; 
this must be created first.  Typing anv2gsas at the DOS prompt will give you the 
information on setting up the EXP file: 
 

 
Figure 26 
 

1. First, follow the anv2gsas instructions to set up the GSAS EXP file.  Matrix 
information is obtained from the overall least squares matrix, and the space group 
should be known. 

2. Type ox80 for the EXPNAM. 
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Figure 27 
 

3. Enter the name of the hkl file (ox80.hkl).   
4. Enter 2; the integrated intensities were obtained using INTEGRATE. 
5. Enter the run number of the first histogram: 9164. 
6. There is no other data so type 1.  (See special instructions if portions of the data 

have already been integrated for preliminary refinements.) 
7. Enter 0 or P and K.  The P value may be changed in GSAS at a later time.  If it is 

desirable to change P and K down the line, anv2gsas can be run again. The 
histograms will then be processed. 

8. At the DOS prompt, type cnvfile.  When prompted for a datafile to convert to 
GSAS format, type ox80.exp.  Hit return again. 

9. Type expedt ox80.exp. 
10. Type y x to make sure the GSAS file is formatted correctly.  You are now ready 

to input atoms and begin refining the structure! 
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Structure Refinement – ox80 
 
GSAS is the standard method of refining single crystal neutron diffraction at IPNS.  It is 
not a structure solution program – structures have usually been solved by x-rays prior to 
the neutron experiment.  If you would like to use SHELX to refine the structure, we 
typically refine extinction in GSAS and then import the data into SHELX.  Contact IPNS 
SCD personnel if you are interested in this – instructions are being formulated for this 
purpose.  
 
GSAS can be downloaded from a link on the SCD webpage.  It is highly recommended 
that the user go through the GSAS tutorial provided with the program to learn how to use 
GSAS; this tutorial will not address these issues as the GSAS tutorial is much more 
thorough.  While PC-GSAS or Brian Toby’s EXPGUI are common ways to use GSAS, if 
the path structure is set up as specified at the beginning of this tutorial the user can type 
the appropriate command (for example expedt, genles, fourier, etc.) at a DOS 
prompt in the working directory. 
 
The initial EXP file (expnam.exp or ox80.exp for this example) was created in the 
anv2gsas step of preparing data for structure refinement, but no atoms were added to the 
file at that time.  The atoms may either be input by hand or by reading in the atoms.txt 
file provided with this tutorial.     
 
General steps in GSAS refinement would follow: 

1. Convergence of the scale factors (no refinement on atom position). 
2. Refine the atomic positions. 
3. Refine the isotropic thermal parameters. 
4. Refine the extinction.  Data from SCD is best handled with a Type I Lorentzian 

correction. 
5. Examine the Fourier difference maps for hydrogen atoms. 
6. Refine the hydrogen atoms as above. 
7. Once the atoms have been found, you can use the program refedt to reject 

disagreeable reflections based on several criteria.  Be careful when using this 
option and ask questions if you need to!  Outliers could result from incorrect 
integration, high extinction and absorption and resolution limitations.  These 
should be checked as a justification for rejecting peaks. You can also use the 
robustness feature to modify weights of outliers in GSAS. 

8. Refine the anisotropic displacement parameters for all atoms. 
9. Examine Fourier difference maps again to check for other problems. 
10. When the structure is complete, run disagl to obtain final bond distances and 

angles with esd’s. 
11. Weighting factors can be added to improve the goodness of fit, which can be 

calculated by taking the square root of CHI2, found in the expnam.lst file. 
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Graphical Representation of the Structure 
 
ORTEP 3 for windows (also part of the WinGX package) will read GSAS EXP files 
directly.  This is the simplest method to produce a picture of the molecule as well as track 
your progress visually while using GSAS. 
 
FOBS and DELF maps can be created in GSAS using the forplot routine. 
 

Writing the Structural Report 
 
This tutorial contains a template file named reporttemplate.doc.  It is a general template 
complete with references to assist in preparation for publication.  Any value that needs to 
be supplied by the user is in red text. 
 
Gsas2cif is a program that will write a basic cif file for deposition of atomic 
coordinates to a database such as the Cambridge Structural Database.  It will not appear 
exactly as a cif generated by SHELX. 
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Glossary 
 
CHI   chi angle 
DETNUM detector number 
DETA  detector angle in the horizontal plane 
DETA2  detector angle out of the horizontal plane 
DN  detector number again, same as DETNUM 
H,K,L  h,k,l 
IPK  neutron counts at peak maximum 
INTI  integrated peak intensity 
MONCNT  incident beam detector monitor counts 
NRUN  run number 
OMEGA  omega angle, fixed at 45 deg. 
PHI   phi angle 
RFLG  reflection flag, usually equal to the crystal number 
SEQN  sequence number 
SIGI  sigma for INTI based on counting statistics 
WL  wavelength in Angstroms 
X,Y,Z  histogram channels 
XCM,YCM distance from the detector center in centimeters 
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Appendix 1 – Using refedt 
 
Refedt is a program used to edit the GSAS single crystal reflection files.  It can be used to 
reject reflections in the refinement based on various criteria.  Use this with care however 
– refedt should not be utilized until most (preferably all) of the atoms have been located 
from the Fourier maps and the refinement is stable near an R(F2) value of 20%.  It is 
important that rejection of data is justifiable (see page 38, number 7). Ideally, rejecting a 
small number of outliers should not affect the model, but should reduce the R-factors. 
 
Refedt is invoked by typing at the DOS prompt: 
 
> refedt 
 
Typical input follows, as well as a listing of the processed reflections.  The file refedt.lst 
is written which contains a log of the input and output.  Refedt can also be run again with 
all “0” values for input to return the data set to its original state, so nothing it truly lost.  
This example is not taken from oxalic acid data. 
 
EXPNAM ==> bpme2    
 
 Number of histograms ==>   34 
 
 
Input minimum wavelength <0.0>:   0.5 
 
Input maximum wavelength <99.0>:   99. 
 
Input minimum extinction correction <0.0>:   0. 
 
Input maximum FOSQ/FCSQ ratio <0 for no test>:   2. 
 
Input maximum FCSQ/FOSQ ratio <0 for no test>:   2. 
 
Input maximum ABS(FOSQ-FCSQ)/SIGFOSQ <0 for no test>:  0 
 
Input maximum FOSQ/SIGFOSQ <0 for no test>:  0 
 
 

 IHST   H    K    L       DSP       LAM      FOSQ   SIGFOSQ      FCSQ     FCTSQ    EXTCOR      TBAR 
 
Processing histogram   1 
    1  -5.   1. -22.     0.514     0.586    54.570    33.960     6.490     3.182     1.000     0.141 
    1  -5.   2. -19.     0.582     0.598    41.120    18.070     3.970     1.947     1.000     0.141 
    1  -4.   1. -22.     0.527     0.628    49.970    23.850     6.930     3.398     1.000     0.140 
    1  -4.   1. -18.     0.630     0.711    69.410    22.520   143.254    70.305     0.999     0.140 
    1  -4.   1. -17.     0.662     0.735    31.890    22.880   103.997    51.033     0.999     0.140 
    1  -4.   2. -19.     0.599     0.655    19.190    16.090    64.285    31.532     1.000     0.141 
    1  -4.   2. -17.     0.660     0.693    14.020    13.280     0.581     0.285     1.000     0.141 
    1  -4.   2. -15.     0.734     0.734    92.440    19.110    28.968    14.208     1.000     0.141 
    1  -4.   3. -22.     0.524     0.564    55.400    41.640     3.344     1.640     1.000     0.141 
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Appendix 2 – Integrating and Processing Portions of 
Data. 
 
There are some instances where it may be valuable to integrate portions of data and 
process them to check for initial structure quality while the remainder of the data is being 
collected, instead of waiting until all of the data has been collected.  In this case saving 
your wizard state at the end of the integration step is very valuable, as it allows you to 
reload the wizard state and change the run numbers for the next portion of data, 
appending it to the files you have already created.  Note that if you reload a saved wizard 
state and reintegrate all of the data that was previously processed, ISAW simply add to 
the existing integrate file and you will have multiple histogram data.  When following 
this procedure, you only need to integrate and process the data you haven’t already 
integrated. 
 
When using the Daily Wizard to integrate portions or remainders of data: 
 

1. Check the Append to File box to make sure that subsequent portions of data 
are included in the expnam.integrate file. 

2. Delete the expnam.hkl file. 
3. Run anvred on the entire expnam.integrate file to generate the new 

expnam.hkl file. 
4. When running anv2gsas on the new hkl file, enter the new “Run number of 

first histogram” from the data you have just processed (not the first histogram 
overall).  You are also prompted to enter 1 if these are the only data or n+1 if 
there are already histograms present.  Here you want to use the n+1 option; for 
example, if you have already processed 5 run files for a total of 10 single 
crystal reflection files, use 11 as your n+1 value. 

5. A file named exp-file.inc should also be generated.  Open this file with a text 
editor and copy the information inside of it. 

6. Open the expnam.exp file with a text editor and replace the relevant 
information with that found in exp-file.inc.  (If the information in exp-file.inc 
is only for the newly generated histograms, append these in the right places.  I 
don’t remember this being the case however.) 

7. Run cnvfile on expnam.exp. 
8. EXPEDT expnam.exp and enter Y X to write the file. 
9. In GSAS, turn off all atom refinement parameters (and extinction) and refine 

the scale factors until they converge. 
10. Turn refinement back on and continue. 

 


